The Legal Network Analyzer (LENA)
and
The Emergency Law Database (ELDB)
User Guides

Section 1.0 Introduction to LENA
NOTE: The content on this site is offered only as a public service and does not constitute solicitation or provision
of legal advice. This site and these tools should not be used as a substitute for obtaining legal advice from an
attorney licensed or authorized to practice in your jurisdiction. You should always consult a suitably qualified
attorney regarding any specific legal problem or matter.
The Legal Network Analyzer (LENA) and Emergency Law Database (ELDB) are tools developed by the
Center for Public Health Practice at the University of Pittsburgh Graduate School of Public Health to help
individuals understand the emergency laws that direct public health system agents (“PHS agents”) to work
collaboratively. The PHS agents serving as the bases for the tools are shown and defined in Figure 1. PHS Agents
Included in LENA and the ELDB.
LENA has three primary uses:
 LENA allows individuals to create a LENA Network Map showing which PHS agents are required by
law to work with other agents in a single jurisdiction.
 LENA allows individuals to create a LENA Network Map that compares which PHS agents are
required to work in one jurisdiction with those PHS agents in a second jurisdiction.
 LENA can be used to access the ELDB, a searchable repository of over 5,900 laws.
LENA Network Maps can be created in 13 jurisdictions: Alaska; California; Florida; Kansas; Maryland; New
York; North Dakota; Ohio; Pennsylvania; Rhode Island; Texas; Wisconsin; and, the federal government.
Figure 1. PHS Agents Included in LENA and the ELDB
PHS Agents
Administrative Agencies: A federal, state, or local
Fire: A federal, state, or local department operating with the
department or agency that is not part of the legislative or
intent and purpose of carrying out the duties, functions,
judicial branches and that has power delegated to it by
powers, and responsibilities normally associated with a fire
Congress or the state legislature to make administrative
department, including the protection of life and property
decisions.
against fire, explosions, and other hazards. This definition
includes both paid and voluntary fire departments. This
definition also includes individuals, fire protection districts, fire
safety organizations which counsel fire departments on best
practices, and fire‐related commissions which set regulatory
measures.
Community Health Center: A public or incorporated
nonprofit health facility that provides comprehensive
primary health care to citizens in a community. This
definition includes poison control centers, drug facilities,
ambulatory care facilities, and renal dialysis facilities. This
definition does not include facilities that primarily provide
behavioral and mental health services.

Governmental Public Health: An organization and its divisions
designated by the federal, state, or local government as having
the usual powers and duties of a board of health or health
department to protect and preserve the public’s health. This
definition includes epidemiologists, medical examiners, and
coroners.

Civic: A non‐profit entity that is organized primarily for civic,
fraternal, or charitable purposes. This definition includes the
American Red Cross, volunteers/volunteer organizations,
food banks, non‐profit organizations such as the Small
Business Association, and libraries.

Home Health Care: An agency that furnishes medical and
custodial care services to ill, disabled, or infirm individuals in
their homes or residences.
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Figure 1. continued
Corrections: An entity responsible for supervising adults and
juvenile offenders, including their confinement, detention,
care, and treatment. This definition includes boards of
probation and parole.

Hospitals: An institution that, under the supervision of
licensed doctors, primarily provides inpatient services for
individuals who are sick, injured, or disabled. This definition
includes rehabilitative facilities, but not facilities that
primarily provide skilled nursing care (such as nursing homes
and other long‐term facilities).

Department of Agriculture: An executive branch agency or
department at the federal or state level responsible for
agricultural development. Responsibilities of departments of
agriculture may also include animal health, plant health,
and/or food safety and inspection.

Laboratory: A facility for biological, serological, biophysical,
cytological, and pathological tests, as well as a facility for the
chemical or other examination of materials from water, air, or
other substances.

Department of Environmental Protection: An executive
branch agency or department at the federal or state level
responsible for ensuring clean air, clean water, and clean soil.
Responsibilities of departments of environmental protection
may also include waste recycling and reduction, seismic
safety and/or the cleanup of hazardous waste sites and spills.
This definition includes agencies as being state‐related
agencies of the Federal Department of Environmental
Protection (see: http://www.epa.gov/epahome/state.htm)
and departments of water resources.

Law Enforcement: A publicly funded public service organization
whose principal activities pertain to crime prevention, control,
reduction of crime, or to enforcement of the law. This
definition includes departments of public safety and motor
vehicles, the FBI, and law enforcement commissions which set
standards and training practices.

Department of Transportation: An executive branch agency
or department at the federal or state level responsible for
the safety and mobility of the transportation system. This
definition includes turnpike commissions.

Long Term Care: A residential facility that provides skilled
nursing care, intermediate care, assisted living facility, home
for the aged (including community care facilities).

Doctor/Health Care Provider: A person required by state or
federal law or regulation to be licensed, registered, or
certified to provide health care services. This definition
includes physicians, nurses, medical examiners/coroners,
pharmacists, social workers, and health care
therapists/specialists.

Mental Health: A medical or non‐medical service designed to
address behavioral and mental health issues. A mental health
professional includes psychiatrists, psychologists, licensed
social workers, licensed professional counselors, psychiatric
nurse specialists, and psychotherapists. This definition includes
psychiatric hospitals.

Elected Officials: Persons voted into positions of
government, including federal, state, county, local, or
regional levels of jurisdiction. Examples include President,
Governor, Commissioner, County Executive.

Public/Individuals: An individual or a group of individuals who
are not subordinate, functionally related, or connected to any
federal, state, or local governmental agencies, or to any of the
other public health agents defined herein.

Emergency Management Agency: A federal emergency
management agency, state office or agency of emergency
management, and/or county or municipal agencies that have
been designated as local emergency management agencies.
This definition does not include emergency management
services, fire departments, law enforcement, or other
agencies defined elsewhere under these definitions.

Schools: A public or private educational institution
encompassing kindergarten through twelfth grade, and post‐
secondary educational institutions, including vocational and
technical schools. This definition does not include day care
centers or tribal schools.

Emergency Medical Service: An entity that provides
immediate stabilization care as required by an emergency.
This definition includes the care and transportation of
individuals by ambulance services and the performance of
authorized emergency care by a physician, professional
nurse, a licensed physician assistant, or other authorized
attendant.

Special Response Team: A complement of individuals or
entities organized with the intent of providing a specified
aspect of emergency preparedness, planning, or response in
accordance with standards developed by a federal, state, local
emergency management agency, or Department of Homeland
Security.

LENA and ELDB Guides

3

Figure 1. continued
Employer: An institution, organization, person, or other
entity that pays a salary or wages to an employee(s). This
definition does not include the United States, any state or
political subdivision of a state, or any agency thereof as an
employer.

Transit: Transportation by a conveyance that provides regular
and continuing general or special transportation to the public.
This definition includes port authorities, transportation
authorities, and water transportation authorities. This
definition does not include school bus, charter, or sightseeing
transportation.

Faith Institution: A church, ecclesiastical, or denominational
organization at which nonprofit religious services and
activities are regularly conducted, and any bona fide religious
group that does not maintain a specific place of worship.
"Religious institution" includes any separate group or
corporation that forms an integral part of a religious
institution that is exempt from federal income tax under the
provisions of section 501(c)(3) of the Internal Revenue Code,
and that is primarily supported by funds solicited inside its
own membership or congregation.

Tribal Health: Any tribe, band, nation, or other organized group
or community, including any Alaska Native village or regional or
village corporation. This definition includes health programs or
facilities pertaining to Indian tribes.

Section 1.1 The Components of LENA
The first screen that appears when LENA is accessed is its Default Screen (Figure 2). The Default Screen is
an otherwise empty page instructing the individual to select a jurisdiction. Hints appear at the left bottom corner.
Figure 2. Default Screen

The individual is instructed to select a state from the “Data” menu. For example, if Alaska is selected, a
network is created showing all the PHS agents involved, along with their connections, as shown in Figure 3, for
epidemic emergencies in the state of Alaska.
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Figure 3. LENA Map for Alaska – Epidemic Emergencies

The networks created through LENA are comprised of circles that represent PHS Agents and lines that
connect PHS Agents if there is a law or a series of laws directing the agents to work together.
 Circles. The circles (or “nodes”) represent the 26 PHS agents shown in Figure 1.
o The size of the circle corresponds to how central the PHS agent is to the network. The larger the circle,
the more central the PHS agent is to the network. On the Alaska network shown in Figure 3,
Governmental Public Health, Administrative Agencies, and None are represented by the largest circles
and are the most central to the network.
 The node “None” is used when a PHS Agent is directed to perform a function, but is not
required to collaborate with any other PHS Agent. For example, a hospital might be required
to prepare an emergency plan but is not be required to work with another PHS Agent to do
so. On the Alaska network shown in Figure 3, Home Health Care, Hospital, Governmental
Public Health, Community Health Center, and Administrative Agency are all connected to the
None node.
o A PHS Agent that is in the network but is not connected to another PHS Agent with a line is an
“Isolated PHS Agent.” This means that the PHS agent is directed to perform a function with itself. For
example, a school nurse may be directed to report a child with an infectious disease to the principal of
the school but not to any outside PHS Agent. On the Alaska network shown in Figure 3, Schools is an
Isolated PHS Agent.
o The PHS Agents on the left hand side of the screen are not legally required to perform any function in
the network. On the Alaska network shown in Figure 3, there are such 15 agents.
 Lines. The lines (or “edges”) connect PHS Agents when there is a law or group of laws directing two PHS
Agents to work together.
o The blue lines are unidirectional, meaning that that one PHS Agent (Acting PHS Agent), is legally
directed to perform a function with another agent (Participating PHS Agent), but the Participating PHS
Agent is not legally required to perform a function with the Acting PHS Agent. All of the relationships
shown in Figure 3 are unidirectional.
o The red lines are bidirectional, meaning that the Acting PHS Agent is legally directed to perform a
function with a Participating PHS Agent and the Participating PHS Agent is legally required to perform
a function with the Acting PHS Agent. There are no bidirectional relationships in the Alaska network
shown in Figure 3.
o The thickness of the lines connecting PHS public agents signifies the number of laws directing the PHS
agents to collaborate (or “frequency”). The thicker the line, the greater the number of laws directing
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functions between the agents. On the Alaska network shown in Figure 3, there are more laws
directing Governmental Public Health and Administrative Agencies to work with None than the other
PHS Agent pairings.

Section 1.2 Creating a LENA Network Map for One Jurisdiction
A LENA Network Map of a single jurisdiction is created by selecting a Show State, an Emergency type, an
Action‐goals pairing, and a Purpose from drop down menus located across the top of the screen. See Figure 4.
LENA Drop Down Menus.
Figure 4. LENA Drop Down Menus

One selection can be made from each of the five drop down menus. In addition, there are two boxes that
can be clicked.
Figure 5. Available Selections from LENA Drop Down Menus







Show State. The Show State is the jurisdiction for which the LENA Network Map is being drawn. There are 13
jurisdictions that can be selected: Alaska; California; Florida; Kansas; Maryland; New York; North Dakota;
Ohio; Pennsylvania; Rhode Island; Texas; Wisconsin; and, the federal government.
Emergency. The Emergency is the type of natural or man‐made disaster. There are 21 types of emergencies
that can be selected. Select “All” to create a LENA Network Map that includes all types of emergencies.
Action‐goals. The Action‐goals are functions that the PHS agents perform. There are 7 specific action‐goal
pairings. Select “All” to create a LENA Network Map that includes all functions.
Purpose. The Purpose means whether the Action‐goals are performed for Emergency Preparedness,
Response, Management, or Recovery. Select “All” to create a LENA Network Map that includes all Purposes.
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Compare State. The Compare State menu is only used when comparing jurisdictions, not for creating a LENA
Network Map for one jurisdiction. See Section 1.3.
Include Non‐Specified Emergencies. Non‐Specified Emergencies occur when a law refers to an emergency,
but does not state specifically what kind of emergency it is.
Show Missing Links Only. The Show Missing Links Only box is only used when comparing jurisdictions, not for
creating a LENA Network Map for one jurisdiction. See Section 1.3 Creating a LENA Network Map Comparing
Two Jurisdictions.

Example of a Network Map for a Single Jurisdiction
Figure 6. LENA Network Map for a Single Jurisdiction

Figure 6 is an example of a LENA Network Map for a single jurisdiction created using the following
selections from the drop down menus:
 Show State: Pennsylvania
 Emergency: Nuclear‐Radiologic
 Action‐goals: All
 Purpose: Preparedness
 Compare State. No Compare State is selected since a single jurisdiction map is being created. Alaska is the
default Compare State.
 Include Non‐Specified Emergencies: Not Selected
 Show Missing Links Only. Not selected since a single jurisdiction map is being created
There are both unidirectional and bidirectional relationships in Figure 6. Emergency Management Agency
and Elected Officials are most central to this network. Fire is an Isolated PHS Agent. Twelve PHS Agents have no
legally directed function in this network. See Section 1.1 Components of LENA for additional information.

Section 1.3 Creating a LENA Network Map Comparing Two Jurisdictions
A LENA Network Map comparing two jurisdictions is created by selecting a Show State, an Emergency
type, an Action‐goals pairing, and a Purpose from drop down menus located across the top of the screen. See
Figure 4. LENA Drop Down Menus.
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Figure 4. LENA Drop Down Menus

One selection can be made from each of the five drop down menus. In addition, there are two boxes that
can be clicked.
Figure 5. Available Selections from LENA Drop Down Menus










Show State. The Show State is the first jurisdiction for which a network map is being drawn. There are 13
jurisdictions that can be selected: Alaska; California; Florida; Kansas; Maryland; New York; North Dakota;
Ohio; Pennsylvania; Rhode Island; Texas; Wisconsin; and, the federal government.
Emergency. The Emergency is the type of natural or man‐made disaster. There are 21 types of emergencies
that can be selected. Select “All” to compare LENA Network Maps that include all types of emergencies.
Action‐goals. The Action‐goals are functions that the PHS Agents perform. There are 7 specific action‐goal
pairings. Select “All” to compare LENA Network Maps that include all functions.
Purpose. The Purpose means whether the Action‐goals are performed for Emergency Preparedness,
Response, Management, or Recovery. Select “All” to compare LENA Network Map that includes all Purposes.
Compare State. The Compare State is the jurisdiction that is being compared to the Show State. There are 13
jurisdictions that can be selected: Alaska; California; Florida; Kansas; Maryland; New York; North Dakota;
Ohio; Pennsylvania; Rhode Island; Texas; Wisconsin; and, the federal government.
Include Non‐Specified Emergencies. Non‐Specified Emergencies occur when a law refers to an emergency,
but does not state specifically what kind of emergency it is. Select this box to compare Network Maps that
include laws that refer to a specified emergency, such as “Epidemic,” as well as those that refer to
“Emergency” in general.
Show Missing Links Only. The Show Missing Links Only will show only the relationships that exist in the Show
State and not in the Compare State.
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Lines on the Network Map Comparing Two Jurisdictions
 Pink lines on a LENA Network Map comparing two jurisdictions show relationships that are similar in both the
Show State and the Compare State.
 Green lines on a LENA Network Map comparing two jurisdictions indicate relationships that are present in the
Show State but not in the Compare State.
 Brown lines on a LENA Network Map comparing two jurisdictions indicate relationships that are present in
the Compare State but not in the Show State.
Example of a Network Map Comparing Two Jurisdiction
Figure 7. LENA Network Map Comparing California and Pennsylvania

Figure 7 is a comparison of legally directed relationships in New York and Texas for surveillance activities
for hurricane emergencies. The following selections were made from the drop down menu:
 Show State: California
 Emergency: Nuclear‐Radiological
 Action‐goals: All
 Purpose: All
 Compare State: Pennsylvania
 Include Non‐Specified Emergencies. The Non‐Specified Emergencies box was not selected.
 Show Missing Links Only. The Show Missing Links Only box was not selected.
There are 26 PHS agent pairings that are the same in California and Pennsylvania, such as Elected Officials
and Business/Employer, and Emergency Management Agency and Administrative Agencies. The green lines
indicate relationships that are present in California, but not in Pennsylvania, such as Business/Employer and Labs.
The brown lines show relationships present in Pennsylvania but not in California, such as Civic and Elected
Officials.
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Section 1.4 Using LENA to Access the Emergency Law Database
The LENA Network Maps act as an interface to the Emergency Law Database. Clicking on a PHS agent (i.e.,
a circles or node) reveals all of the laws pertaining to that agent in the created network. Clicking on the lines
between PHS agents reveals all of the laws pertaining to both of the agents in the created network.

Section 1.5 Changing the Look of the LENA Network Maps
Options in the Layout Menu are used to change how LENA Network Maps look. The individual can access
the LENA Layout Menu by left clicking the Layout Menu option in the upper left hand corner of the screen. The
screen shot in Figure 8 shows the various options to change the look of the network map.
Figure 8. Options to Change the Look of a LENA Network Map

The options for changing how the LENA Network Maps look can be grouped into different sets such as the
commands for zoom, line length, and node size.
 Zoom: Zoom adjusts the distance from which the network is visualized. “Adjust Zoom Automatically” adjusts
the zoom level so that the network fits the screen.
 Spring Length, Spring Stiffness, Spring Damping, Node Radius, Node Strength, Node Damping: These options
can be used to adjust the distance between the nodes, the speed of drawing and its settlement.
 Invert Background: Click this option to invert the color of the screen. A light colored background becomes
dark and dark objects (lines and nodes) become light colors.
 Draw Fish‐Eyed: Click on this option to zoom in on the central part of a network. This is useful if the central
part of the network looks very crowded.
 Line Weight, Line Thickness, Line Alpha: These options change the size ratio of arrows and line, the thickness
of lines, and the visibility of lines, respectively.
 Min Node Diameter, Node Diameter Factor, Node Size Factor: These commands change the parameter size
of the nodes.
 Show Labels: Click on this option to show or hide PHS agent labels.
 Other Commands and Shortcuts:
o Mouse clicks:
 Click + Drag—Drags the canvas or agent
 Shift + Click—shows explanations about the agent
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o
o
o
o
o

Double Click—opens the Emergency Law Database and shows the statutes citing the agent
(when clicked on an agent) or the pair of agents (when clicked on a line)
Arrow up/down: Zoom in/out
l/d: open/close layout and data menus
s/p: save a screen snapshot in png/pdf format
f: freeze/unfreeze the network (this stops the movement of the nodes trying to settle down)
2: toggle fish‐eyed view

Section 2.0 Introduction to the Emergency Law Database
NOTE: The content on this site is offered only as a public service and does not constitute solicitation or provision
of legal advice. This site and these tools should not be used as a substitute for obtaining legal advice from an
attorney licensed or authorized to practice in your jurisdiction. You should always consult a suitably qualified
attorney regarding any specific legal problem or matter.
The Emergency Law Database (ELDB) is a tool developed by the Center for Public Health Practice at the
University of Pittsburgh Graduate School of Public Health to help individuals understand the emergency laws that
direct public health system agents (“PHS agents”) to work collaboratively. See Section 1.0 Introduction to LENA
for a description of the PHS Agents.
ELDB is a searchable repository of over 5,900 emergency laws analyzed in the PHASYS project in
13jurisdictions: Alaska, California, Florida, Kansas, Maryland, New York, North Dakota, Ohio, Pennsylvania, Rhode
Island, Texas, Wisconsin, and the federal government. The ELDB does not contain every emergency law in these
jurisdictions. The purpose of the PHASYS project is to look at which PHS agents are legally directed to work
collaboratively with others for emergency preparedness, response, and recovery activities. As such, certain types
of laws were deemed to be outside of the scope of this project, including most fiscal matters, laws concerning
Methicillin‐resistant Staphylococcus aureus, hospital‐acquired diseases, sexually transmitted infections, and
HIV/AIDS. Routine safety measures were not included as emergency measures.

Section 2.1 Using the ELDB
The first screen that appears when the Emergency Law Database is accessed is its Default Screen (Figure
9).
Figure 9. ELDB Default Screen
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Laws are searched by terms entered in the Enter the Keyword(s) space. Entering a single term, for
example, “quarantine,” brings up all of the laws that contain that word. Two or more terms, such as “quarantine”
and “isolation” can also be entered in the Enter the Keyword(s) space. Multiple terms must be separated by a
comma. Clicking “or” to the right of the keywords will bring up all the laws that contain either term. Clicking “and”
to the right of the keywords will bring up all the laws that contain both the terms. A listing of citations appears
under the “Your results will appear here” column on the left‐hand side of the screen. Clicking on the citation will
take the individual to the full text of the statute or regulation.
The scope of laws can be narrowed by selecting one or more qualifier described below. A single qualifier,
multiple qualifiers, or all qualifiers can be selected.
 Jurisdiction. Laws can be searched in one or more of the following jurisdictions: Alaska; California; Florida;
Kansas; Maryland; New York; North Dakota; Ohio; Pennsylvania; Rhode Island; Texas; Wisconsin; and, the
federal government.
 Acting Agents. Acting agents are those entities and individuals legally directed to perform a function.
o Nodes. A single acting agent, multiple acting agents, or all 26 acting agents can be selected.
o Subsets. Subsets represent the level of the acting agent, such as federal, state, or local.
o Footnotes. These entities and individuals are in addition to the 26 PHS agents. The footnoted agents
are not represented in the LENA network maps.
 Participating Agents. Participating agents are those entities and individuals with which acting agents are
legally directed to perform functions.
o Nodes. A single participating agent, multiple participating agents, or all 26 participating agents can be
selected.
o Subsets. Subsets represent the level of the participating agent, such as federal, state, or local.
o Footnotes. These entities and individuals are in addition to the 26 PHS agents. The footnoted agents
are not represented in the LENA network maps.
 Additional Search Parameters
o Emergencies. The Emergency is the type of natural or man‐made disaster.
o Actions. Actions are the verbs characterizing what is to be done, such as “prepare.”
o Goals. Goals are the object of the action, such as “a plan.”
o Prescriptions. Prescriptions are whether the law states a mandate, a prohibition, or an option.
o Conditions. Conditions are a precipitating event, such as “when an emergency is declared.”
o Timeframes. Timeframes are the period during which an Action/Goal activity is to take place, such as
“immediately” or “within 24 hours.”
o Purposes. Purposes are whether the Action/Goal activities are for emergency preparedness,
mitigation, response, or recovery.
The number of citations that appear per screen can be selected at the bottom of the screen.
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